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CHAPTER 1

Introduction
Supported In:

You can insert images into content files (e.g., topics, snippets). Flare supports the following types
of raster and vector image files: BMP, EMF, EPS, EXPS, GIF, HDP, JPG, JPEG, PDF, PNG, PS, SVG,
SWF, TIF, TIFF, WDP, WMF, XAML, XPS. You can also add animated GIFs to content files, just as
you would add a regular image. However, you need to use a third-party tool to create the animated
GIF, then add it to the Flare project.

Main Activities

n "Adding Images to Projects" on page 9

n "Inserting Images" on page 11

n "Managing Screen Captures" on page 22

n "Editing Images" on page 38

n "Linking Images" on page 53

Other Information

n "Raster vs. Vector Images" on page 80

n "PDF Files as Images" on page 84
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n "Image Features Per Output Type" on page 88

Other Activities

n "Selecting an Image for the About Box" on page 90

n "Deleting and Removing Images" on page 92

n "Creating a List of Images" on page 102

n "Opening Images" on page 104

n "Adding Images to Page Layout Frames" on page 105

n "Pasting Images From Other Programs" on page 107

n "Pinning Images" on page 109

n "Regenerating Images" on page 115

n "Viewing Unused Images" on page 117

n "Showing and Hiding Web Images in the XML Editor" on page 119

n "Generating Web-Safe Images" on page 120

n "Embedding Images in Word Output" on page 121

TIP For print-based output, try to use images with a high DPI (dots per inch) quality (300 is
recommended). The higher the DPI, the more it shrinks in the output. Try to obtain as large
an image as possible to begin with. If that doesn't work, a lower DPI (e.g., 250, 200, 150)
may produce acceptable results in print output. By contrast, online output is displayed at 72
or 96 DPI, so a lower DPI image is okay. To produce the best possible images for online and
print-based outputs, consider using different images for those outputs and applying
conditions to them. Another option is to use single-sourcing features with MadCap Capture,
which lets you accomplish the same thing with only one image for online and print outputs.

NOTE When you insert an image from outside your project into a topic, a copy of the image
file is added to your project. The image file is stored in the Resources > Images folder of the
Content Explorer, unless you specify another location.
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NOTE If you import Microsoft Word documents containing embedded images into a
project, Flare places copies of those image files in subfolders within the Resources >
Images folder. This is done in order to avoid naming conflicts with embedded images from
other Word documents that you might import. The subfolders are named after the Word
documents being imported.

NOTE If you apply certain special effects or artwork (e.g., arrows) to images in Word and
then import them into Flare, those effects will not be retained. For example, a rotated image
will return to its straight, original state. However, there are some workarounds that may
allow you to keep the effects or artwork. One solution is to apply another effect such as a
shadow or 3-D to the image in Word (e.g., add a shadow to a rotated image that you want
to keep). This forces Word to save the image as an entirely new image with the effects.
Another possible solution is to save the Word document as a web page, manually copy that
HTM file into the Flare folder, and then open it within Flare. As for text floating around
images, this effect is not supported in Flare. When you import from Word, the text is added
below the image.

NOTE If you have used non–web-safe image formats (e.g., WMF, EMF, BMP, TIF, TIFF) in
your project and want those images to be converted to web-safe formats (e.g., GIF, JPEG,
PNG) when you generate online output—e.g., HTML5, Clean XHTML, Eclipse Help, Microsoft
HTML Help, WebHelp, WebHelp Plus—you can use an option on the Advanced tab of the
Target Editor. For print-based output types (Adobe PDF, Microsoft Word), the original
image file formats will be used when you generate output.
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CHAPTER 2

Main Activities for Images
Some activities are particularly common and important when it comes to this feature.

This chapter discusses the following:

Adding Images to Projects 9

Inserting Images 11

Managing Screen Captures 22

Editing Images 38

Linking Images 53
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Adding Images to Projects
The following steps show you how to add an image to your project, without inserting it into a
content file. If you follow the steps for inserting an image, the image file is added to the project as
well.

How to Add an Image File to a Project
1. Do one of the following, depending on the part of the user interface you are using:

n (Recommended) Right-Click In the Content Explorer, right-click on a folder and from the
context menu select New > Image.

TIP When adding a new file to the Content Explorer, the recommended method
is to right-click on the folder in the Content Explorer and use the New menu
option. This is the most efficient way to direct the new file to the folder where
you want to store it. That's because the Add File dialog opens when you add a
new content file, and this method ensures that the folder you want is already
selected in that dialog.

n Ribbon Select Project > New > Image.

2. Click the File Type field at the top of the dialog and select Image.

3. In the Source area select to add a new file from a template or choose an existing one. For
images, you most likely will select New From Existing, then click to select the file.

4. (Optional) The Folder field is automatically populated with the folder that has focus in the
Content Explorer. If you want to place the file into a folder that you previously created in the
Content Explorer, in the Folder field click and select the subfolder. Otherwise, keep the
default location.
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Non-Topic File Type Recommended Default Folder in Content Explorer

Branding Resources > Branding

Image Resources > Images

Micro Content Resources > MicroContent

Multimedia Resources > Multimedia

Page Layout Resources > PageLayouts

Snippet Resources > Snippets

Stylesheet Resources > Stylesheets

Table Stylesheet Resources > TableStyles

Template Page Resources > TemplatePages

5. In the File Name field, type a new name for the image file.

6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click and select the file tags you want to apply. Click OK.

8. Click Add. The image file is added to the Content Explorer.
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Inserting Images
The following steps show you how to insert an image into a content file (e.g., topic, snippet), adding
the image file to the project as well if necessary. If instead you follow the steps for adding an image
to a project, the image file is added to the project, but not inserted into a topic.

How to Insert an Image—Dialog Method
1. Open the content file.

2. In the XML Editor place your cursor where you want to insert the image.

3. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Insert > Image.

n Keyboard Shortcut Press CTRL+G.

n Local Toolbar Click the face of the button.

n Right-Click Right-click in the editor and select Insert > Image. This context menu option
is available only when your cursor is located in certain places in the editor (e.g., not in a
drop-down effect).

4. Select the General tab.
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5. Navigate to the image that you want to insert and select it. By using the buttons in the local
toolbar, you can view all image files in a list, view files in their folder structure, and use other
options. If you want to add one of your 20 most recently used images to the project, you can
select an image from the Recently Used Images group. If you want to add one of your
pinned—or favorite—images to the project, you can select an image from the Pinned Images
group. You also can click to find and select an image file outside of the project.

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).
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EXAMPLE When you insert an image, the dialog might look something like this:

NOTE If you select an image outside the project, that file is then copied and placed
inside the project. The image file is stored in the Resources\Images folder of the
Content Explorer.
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6. (PDF Images Only) If you selected a PDF file to insert as an image, the Preview section shows
a Page field. In this field, select the specific page you want to insert from the PDF file.

7. (Optional) If you want to apply a specific style class to the image, you can select it from the
Style Class field.

EXAMPLE You have created in your stylesheet a class of the img style called
"button" (i.e., img.button) and you have set a maximum size on that style class. The
idea is that you want to use that style class whenever you insert an image of a
button, ensuring that the image always displays in a very small size. Rather than
using the default parent img style when you insert the image, you select img.button
from the Style Class drop-down.

8. (Optional) In the Screen Tip field you can type a phrase that will appear when the end user
hovers over the image.
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9. (Optional) In the Alternate Text field you can type alternate text to display when the image is
not available, such as when a disabled individual is using a screen reader.

For more information see the online Help.

10. (Optional) In the Tab Index field you can enter a value to specify the order in which users can
tab through images in a topic. So when a user presses the TAB key the first time in a topic,
the image with an index value of 1 will be selected first, the image with a value of 2 will be
selected next, and so on. If you want to skip an image, enter -1 in that field.

EXAMPLE You have a table with two columns and two rows, with an thumbnail
image in each cell. You want users to be able to quickly browse through them using
the TAB key, so that they can select an image and then press ENTER to temporarily
enlarge the thumbnail to full size. Without tab indexes set, the images will be selected
in a horizontal order as the user presses the TAB key (i.e., the image in the first cell is
selected first, followed by the image in the cell to the right, followed by the image in
the first cell of the second row, and finally the second image in the second row).
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However, you want the images do be selected downward (i.e., selecting those in the
first column before those in the second column). Therefore, you edit each image and
enter the appropriate tab index value on it.

NOTE This feature is supported only in web outputs—HTML5, Clean XHTML,
WebHelp, WebHelp Plus.

11. (Optional) Select Apply the alternate text and screen tip to all image references if you want
the same alternate and screen tip text to be used everywhere the image is used in the project.
However, this option will not affect new insertions of the image in the project; you would need
to add the alternate or screen tip text to those images manually.

12. (Optional) Use any of the other tabs to provide additional settings for the image.

SIZE AND PRINT SIZE TABS

You can use these tabs to resize the image. If you want to provide only one group of settings
for the image, select the Size tab. If you want to provide two groups of settings, use both the
Size and Print Size tabs. The Size tab is for targets that are using the default medium or a
custom medium. The Print Size tab is for targets that are using the print medium.

POSITION TAB

You can use this tab to adjust the positioning of the image on the page. This includes the
ability to wrap text around an image or float an image outside the frame holding the regular
flow of text. See
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NOTE You can also use absolute position (i.e., text wrap) on images via the context
(right-click) menu.

THUMBNAIL TAB

You can use this tab to create a thumbnail version of the image in the output.

BORDERS & MARGINS TAB

You can use this tab to set borders, margins, or padding for the image.

BACKGROUND TAB

You can use this tab to add background settings (e.g., color, image) for the image.

13. Click OK.

14. Click to save your work.
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How to Insert an Image—Drag and Drop Method
You can insert images by dragging and dropping the image file from the Content Explorer or File
List window pane to the XML Editor.

With this method, you can specify any necessary advanced settings for that image only after it is
inserted (to do this, right-click on the inserted image and select Image Properties).

1. Open the Content Explorer or File List window pane.

If necessary, make sure you float and position the window pane or editor so that you can see
both it and XML Editor at the same time.

2. Click and drag the image file from the Content Explorer or File List window pane to the
location where you want it in the XML Editor and drop it.

3. Click to save your work.

How to Insert an Image—Toolbar Method
1. Open the content file.

2. Place your cursor where you want to insert the image.

3. In the local toolbar at the top of the XML Editor click the down arrow next to . This
expands the Insert Image drop-down, where you can see your pinned images and the 20 most
recently used images.

4. Navigate to the image that you want to insert and select it.

5. Click to save your work.
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What’s Noteworthy?

NOTE If you need to insert an image that does not appear in the Pinned Images or Recently
Used Images groups, you can select More Images to open the Insert Image dialog.

NOTE Images must appear in the Recently Used Images group before they can be pinned.
If the image you want to pin does not appear in the Recently Used Images group, you can
add it to a content file by dragging it from the Content Explorer or using the Insert Image
dialog.

NOTE The Recently Used Images and Pinned Images groups show the relative path
location of each image. Hover over any image to see its full file path.

NOTE You can expand or collapse the Recently Used Images and Pinned Images groups by
clicking the arrows next to each group name.

NOTE The previous steps are for inserting an image file that already exists. However, you
can also capture an image and insert it into a topic at the same time if you also have
MadCap Capture installed. See "Inserting Screen Capture Images" on page 30.
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NOTE You can also make any image in your online Help interactive by linking it to another
topic, bookmark within a topic, or an external file such as a website.

NOTE If you import Microsoft Word documents containing embedded images into a
project, Flare places copies of those image files in subfolders within the Resources >
Images folder. This is done in order to avoid naming conflicts with embedded images from
other Word documents that you might import. The subfolders are named after the Word
documents being imported.

NOTE If you are using the "generate web-safe images" option in WebHelp targets, images
that link to external locations, such as websites, are not affected by that option. See
"Generating Web-Safe Images" on page 120.

NOTE You can include images in topics that you send for review.

NOTE You can use a global setting in the XML Editor tab of the Options dialog (File >
Options). This automatically adds an empty alt tag to images when you insert them into a
topic or snippet (unless you specifically add an alt tag to an image).
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Managing Screen Captures
You can manage screen captures through the following:

Adding Screen Capture Files to Projects
Capture is MadCap's screen capture and editing tool, which is tightly integrated with Flare. If you
have Capture installed on your computer, you can use it to do any of the following from within Flare.

You can capture an image on your screen and add the image file to the project (without inserting
the picture into a topic).

How to Add a Screen Capture File to a Project
1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Project > New > Screen Capture.

n Right-Click In the Content Explorer, right-click on a folder and from the context menu
select New > Screen Capture.

The Screen Capture dialog opens.

2. Complete the appropriate setup fields in the dialog:

n File name Enter a name for the image that you are capturing, or you can use the default
name provided.

n Folder Select the folder where you want the captured image to be stored in the Content
Explorer.

n Profile or Format Select the profile or file format that you would like to use when
capturing the image. If you select a file format (BMP, GIF, JPEG, PNG, TIFF), the image
will automatically be saved in that format. A profile (created in MadCap Capture) lets
you capture the image with many additional settings applied to the image in advance.

n Launch MadCap Capture Editor Select this check box if you want MadCap Capture to
be launched when you capture an image. The image will be displayed in MadCap
Capture. This is a useful option if you want to edit the image (e.g., add callouts, lines,
borders) after you capture it. When you edit and save the image in Capture, the
changes will automatically be reflected in Flare.
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3. Select the capture option that you want to use, and complete the steps for each one as
necessary:

n Capture UI Element Captures a fixed area of a window (e.g., menu bar, toolbar, editor,
individual button, entire window), depending on where you move your mouse and click.
As you move the mouse in an application, a red border surrounds each separate region.

n Capture Application Captures an open application. When you click this button, the
Select window opens, displaying a list of all open applications. You can select the
application that you want to capture.

n Capture Region Captures a rectangular region of your computer screen. When you click
this button, a rectangle with a red border displays over your screen. You can move and
resize this rectangle in several ways.

DRAG EDGE

You can resize the capture area manually by clicking any of the handles (small squares)
around the edge of the rectangle and dragging them to resize the width and/or height.
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MOVE ENTIRE CAPTURE AREA

You can move the entire capture area by clicking the size-all icon in the center of the
area and dragging the area to a new location on your screen.
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TYPE WIDTH OR HEIGHT

You can click in the number fields in the task bar to manually change the width and/or
height of the capture window in pixels.
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SELECT CAPTURE SIZE

You can click the drop-down arrow and select a preset size for the capture window.
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SELECT AN APPLICATION

You can click the down arrow and select Snap to Window to choose an application to
capture. This option will capture the application at its current size.

NOTE Capture will ignore applications that have been minimized. If you want
these applications to appear as selections in the Select Window dialog, ensure
they are open and have not been minimized.
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SELECT MOVE WINDOW INTO RECTANGLE

You can click the down arrow and select Move Window into Rectangle to choose an
application to capture. This option will minimize the application window to fit into the
capture area you drew.

NOTE Capture will ignore applications that have been minimized. If you want
these applications to appear as selections in the Select Window dialog, ensure
they are open and have not been minimized.

To capture the region, click the red capture button on the task bar.
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n Capture Regions Consecutively Lets you capture multiple images without having to
select the capture option each time. The most recent capture region is shown each
time. In between each consecutive capture, you can relocate and resize the region as
well as manipulate the onscreen content you want to capture. When you are done
capturing images, click the X to finish.

NOTE This feature is available only when adding screen captures, not inserting
them.

CHAPTER 2  29



Inserting Screen Capture Images
If you have MadCap Capture installed on your computer, you can use it to capture an image from
your screen and insert it into a topic at the same time.

How to Insert a Screen Capture
1. Open the content file.

2. In the XML Editor, place your cursor where you want to insert the image.

3. Select Insert > Screen Capture. The Screen Capture dialog opens.

4. Complete the appropriate setup fields in the dialog.

n File name Enter a name for the image that you are capturing, or you can use the default
name provided.

n Folder Select the folder where you want the captured image to be stored.

n Profile or Format Select the profile or file format that you would like to use when
capturing the image. A profile (created in MadCap Capture) lets you capture the image
with many additional settings applied to the image in advance.

n Launch MadCap Capture Editor Select this check box if you want MadCap Capture to
be launched when you capture an image. The image will be displayed in MadCap
Capture. This is a useful option if you want to edit the image (e.g., add callouts, lines,
borders) after you capture it. When you edit and save the image in Capture, the
changes will automatically be reflected in Flare.
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5. Select the capture option that you want to use, and complete the steps for each one as
necessary.

n Capture UI element Captures a fixed area of a window (e.g., menu bar, toolbar, editor,
individual button, entire window), depending on where you move your mouse and click.
As you move the mouse in an application, a red border surrounds each separate region.

n Capture application Captures an open application. When you click this button, the
Select window opens, displaying a list of all open applications. You can select the
application that you want to capture.

n Capture region Captures a rectangular region of your computer screen. When you click
this button, a rectangle with a red border displays over your screen. You can move and
resize this rectangle in several ways.

DRAG EDGE

You can resize the capture area manually by clicking any of the handles (small squares)
around the edge of the rectangle and dragging them to resize the width and/or height.
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MOVE ENTIRE CAPTURE AREA

You can move the entire capture area by clicking the size-all icon in the center of the
area and dragging the area to a new location on your screen.
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TYPE WIDTH OR HEIGHT

You can click in the number fields in the task bar to manually change the width and/or
height of the capture window in pixels.
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SELECT CAPTURE SIZE

You can click the drop-down arrow and select a preset size for the capture window.
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SELECT AN APPLICATION

You can click the down arrow and select Snap to Window to choose an application to
capture. This option will capture the application at its current size.

NOTE Capture will ignore applications that have been minimized. If you want
these applications to appear as selections in the Select Window dialog, ensure
they are open and have not been minimized.
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SELECT MOVE WINDOW INTO RECTANGLE

You can click the down arrow and select Move Window into Rectangle to choose an
application to capture. This option will minimize the application window to fit into the
capture area you drew.

NOTE Capture will ignore applications that have been minimized. If you want
these applications to appear as selections in the Select Window dialog, ensure
they are open and have not been minimized.
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To capture the region, click the red capture button on the task bar.

6. Click to save your work.

NOTE When you insert a screen capture into a topic, the image file is added to your project.
The image file is stored in the Resources\Images folder of the Content Explorer. If the
screen capture image has a .props file (used for storing layer information for the image),
that file is included in the project as well, although it is hidden.
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Editing Images
You can edit images in various ways.

How to Use a Style to Edit Image Properties
1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. From the area below, select the img style. If you created classes of the style, you can expand
img and select the class instead.

5. Use the properties section on the right side of the editor to apply settings for the style. See
the online Help for more details.

6. Click to save your work.

7. If you made the style changes to an image style class, apply that class to the image where it
is inserted.
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How to Open Images in MadCap Capture for
Editing

1. Do one of the following:

n Open a topic where the image is inserted. Right-click on the image.

OR

n In the Content Explorer, locate and right-click the image file that you want to edit (e.g.,
Resources > Images > NameOfFile.png).

2. From the context menu select Edit With MadCap Capture. The image opens in MadCap
Capture.

3. Edit the image in Capture. For details, see Capture's online Help.

4. Save your work in Capture.
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Resizing Images
You can resize images with various methods. 

How to Resize Images via Styles (Recommended)
1. From the Medium drop-down in the Stylesheet Editor, make sure the proper medium is

selected before you begin. In the Advanced view, you can open multiple mediums at once;
you just need to look at the title at the top of the medium pane and make sure you are
working in the correct one. If you are not using stylesheet mediums for your different outputs
or if you want all mediums to have the same settings, just leave the medium set to default
and continue.

Mediums can be used if you want to use one group of settings for online output types and
another group of settings for print-based output types. For example, you might use the
default medium for your online outputs and the print medium for your print outputs.

Please note that Flare remembers the last medium that you used when working in the
stylesheet, so it may or may not be the one that you want to use the next time around.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. From the area below, select the img tag. If you created classes of the tag, you can expand the
img style and select the class instead.

EXAMPLE You are creating a PDF manual that is 8 inches wide and you want to
ensure that none of your largest images are wider than 6 inches. You can create a
class of the img style and name it "MaxWidth6Inches." For most of your images, you
can use the parent img style, but for the large ones, you can use the
img.MaxWidth6Inches style class. The large images will automatically be resized if
necessary so that they are no wider than 6 inches.

5. From the Show drop-down list on the upper-right side of the editor, select .
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6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. In the Box group, you can specify a precise width or height for the style. Alternatively, in the
Unclassified group, you can specify a maximum or minimum width or height (max-height,
max-width, min-height, min-width).

TO SET A PRECISE WIDTH AND/OR HEIGHT

a. If you are using the group view, expand the Box group.

b. To the right of height and/or width, click , and complete the fields in the popup. Enter
a value in the lower-left area and choose from several different units of measurement
(points, pixels, centimeters, etc.) in the lower-right area. Click OK when you are finished.

TO SET THE MAXIMUM WIDTH AND/OR HEIGHT

If the original image is larger than the maximum width or height that is set, it will be reduced
in size so that it is no greater than the maximum value. If the original image is smaller than
the maximum width or height, it will not be resized.

a. If you are using the grouped view, expand the Unclassified group.

b. To the right of max-height and/or max-width, click , and complete the fields in the
popup. Enter a value in the lower-left area and choose from several different units of
measurement (points, pixels, centimeters, etc.) in the lower-right area.  Click OK when
you are finished.

To Set the Minimum Width and/or Height

If the original image is smaller than the minimum width or height that is set, it will be enlarged
so that it reaches the minimum value. If the original image is larger than the minimum width
or height, it will not be resized.

a. If you are using the grouped view, expand the Unclassified group.

b. To the right of min-height and/or min-width, click , and complete the fields in the
popup. Enter a value in the lower-left area and choose from several different units of
measurement (points, pixels, centimeters, etc.) in the lower-right area.  Click OK when
finished.

8. Click to save your work.

To apply a particular style class to an image (after you create it in the Stylesheet Editor), simply
right-click the image where it is inserted. Then from the menu, select Style Class and choose the
appropriate style.
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How to Resize Images via Local Properties
1. Open the content file.

2. Right-click on the image.

3. From the context menu, select Image Properties. The Image Properties dialog opens.

4. If you want to provide only one group of settings for the image, use the Size tab. If you want
to provide two groups of settings, use both the Size and Print Size tabs. When you generate a
target that is using the default or a custom medium (specified on the Advanced tab in the
Target Editor), the settings on the Size tab will be used; when you generate a target that is
using the print medium, the settings on the Print Size tab will be used.

TO SET A PRECISE WIDTH AND/OR HEIGHT

In the Width and/or Height field of the Size section, provide the settings. First you need to
select Length in the top drop-down list. You can then enter a value in the lower-left area and
choose from several different units of measurement (points, pixels, centimeters, etc.) in the
lower-right area. 

TO SET THE MINIMUM WIDTH AND/OR HEIGHT

If the original image is smaller than the minimum width or height that is set, it will be enlarged
so that it reaches the minimum value. If the original image is larger than the minimum width
or height, it will not be resized.

In the Width and/or Height field of the Minimum Size section, provide the settings. First you
need to select Length in the top drop-down list. You can then enter a value in the lower-left
area and choose from several different units of measurement (points, pixels, centimeters,
etc.) in the lower-right area. 

CHAPTER 2  42



TO SET THE MAXIMUM WIDTH AND/OR HEIGHT

If the original image is larger than the maximum width or height that is set, it will be reduced
in size so that it is no greater than the maximum value. If the original image is smaller than
the maximum width or height, it will not be resized.

In the Width and/or Height field of the Maximum Size section, provide the settings. First you
need to select Length in the top drop-down list. You can then enter a value in the lower-left
area and choose from several different units of measurement (points, pixels, centimeters,
etc.) in the lower-right area. 

5. Click OK.

6. Click to save your work.

How to Resize Images Locally via Dragging
1. Open the content file.

2. Hover over the image. An icon displays in the lower-right corner of the image.

3. Click on the icon and drag your mouse either up and to the left (to reduce the size of the
image) or down and to the right (to increase the size of the image).

4. Click to save your work.

How to Reset the Size of an Image
1. Open the content file.

2. Right-click on the image.

3. From the context menu, select Reset Size. The image returns to its original size.

4. Click to save your work.
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What’s Noteworthy?

NOTE When you click on an image file in the user interface (e.g., Content Explorer or File
List window pane), its resolution and dimensions are displayed at the bottom. If you have
set the online or print DPI for an image using MadCap Capture, these values are also
shown.

NOTE You can also use show images as small thumbnails in the output (either by using
styles or locally). End users can see the full size of the image by hovering over it or clicking
it. See "Showing Images as Thumbnails in Output" on page 46.

NOTE When resizing objects, you can ensure the aspect ratio is maintained. For example, if
you want certain objects to be resized so that each is exactly 3 inches high, you can make
sure the width of each object is adjusted accordingly to stay in proportion. To do this, first
set the height at 3 inches. You would not set the width property at all. In the same way, if
you were to specify an exact width, you could maintain the aspect ratio by not setting the
height.

NOTE Please be aware that if you are using percentage for the size of an object, the
percentage refers to the block containing that object, not to the object itself. For example, if
you have an object in a topic and set the width to 60%, this does not mean that the object
will be reduced to 60% of its size. Instead, it means that the object will be resized so that its
width is 60% of the "container" where it is inserted.
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NOTE When you use Flare's resizing features to scale images, you can specify whether you
want Flare to pre-compile the resized images. You can do this for the online outputs
(HTML5, Clean XHTML, Eclipse Help, Microsoft HTML Help, WebHelp, WebHelp Plus), as
well as for Microsoft Word output. What does this mean? It means that Flare will create
new copies of images wherever you have specified resizing, rather than relying on the
browser to render the new size from the original. This means better quality images, but it
also means more image files in the output. It is recommended that you leave the default
pre-compile setting as it is (enabled). However, if you want to disable it, you can open the
Target Editor, select the Advanced tab, and select Generate resized copies of scaled
images to remove the check mark. (For Adobe PDF output, the resized images will always
be pre-compiled, whether this option is enabled or not.)
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Showing Images as Thumbnails in Output
Supported In:

When you insert images into Flare content, you can specify that the images should be displayed as
thumbnails (i.e., much smaller versions of the image) in the output. This is a way to condense
topics so that images are not taking up as much real estate. When you use this feature, you can
specify ways that the user can enlarge the image to see its full size (e.g., by hovering over the
thumbnail, by clicking the thumbnail).

This can be done through styles or by using local formatting. Using styles is usually recommended
because the setting is automatically applied to any content using that style throughout the project,
whereas local formatting affects only the particular content that you are working on.
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How to Create Thumbnail Images by Using Styles
1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the online Help.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. Select the appropriate image style. For example, you can select the parent img tag, or you can
expand the img style select a class that you may have created.

EXAMPLE You are creating a Help system that contains small images (e.g., less
than 48 pixels high) as well as bigger images (e.g., larger than 48 pixels high).
Suppose you want all of the bigger images to appear as thumbnails in the output. In
that case, you might create a class of the img style and name it "BigImages." For the
smaller images, you can use the parent img style (or even a style class), but for the
larger ones, you can use the img.BigImages style class. The large images will
automatically be displayed as thumbnails in the output, until the end user performs
an action to see the image in its full size.

5. From the Show drop-down list on the upper-right side of the editor, select .

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. If you are using the group view, expand the Thumbnail group.

CHAPTER 2  47



8. To the right of mc-thumbnail, click and select one of the following:

n hover The end user can see the image in its full size by hovering the mouse over the
thumbnail. As a result, the full size of the image will be shown in a popup window.

n link The end user can see the image in its full size by clicking the thumbnail. As a result,
the full size of the image will be shown.

n popup The end user can see the image in its full size by clicking the thumbnail. As a
result, the full size of the image will be shown in a popup window.

NOTE If you enter none, the image will not be shown as a thumbnail. If you enter
normal, the image will be replaced with its thumbnail.

9. If you want to set a maximum height or width for thumbnail images, click to the right of
mc-thumbnail-max-height or mc-thumbnail-max-width and complete the fields. You probably
only need to complete one of these areas with the other set to auto.

The default setting is to show images as thumbnails if they are more than 48 pixels high. If
that is the case, the image will be resized in the output to be 48 pixels high, and the width will
be adjusted accordingly. The image will be shown in its full size when the user performs one
of the actions you specified in the previous step.

If you want to change either the maximum width or height settings, click to the right of either
field and enter the appropriate width or height (e.g., 60px, 1in).

10. Click to save your work.

To apply a particular style class to an image (after you create it in the Stylesheet Editor), simply
right-click the image where it is inserted. Then from the menu, select Style Class and choose the
appropriate style.
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How to Create Thumbnail Images by Using Properties
1. Open the content file.

2. Right-click on the image.

3. From the context menu, select Image Properties. The Image Properties dialog opens.

4. Select the Thumbnail tab.

5. In the area on the left, select one of the options.

n Mouse Over The end user can see the image in its full size by hovering the mouse over
the thumbnail. As a result, the full size of the image will be shown in a popup window.

n Hyperlink The end user can see the image in its full size by clicking the thumbnail. As a
result, the full size of the image will be shown.

n Popup The end user can see the image in its full size by clicking the thumbnail. As a
result, the full size of the image will be shown in a popup window.

NOTE If you select None, the image will not be shown as a thumbnail. If you select
Inherit, the image will use whatever thumbnail settings are applied to the parent
<img> tag.

6. If you want to set a maximum width or height for thumbnail images, complete the Max Width
or Max Height fields. You probably only need to complete one of these areas with the other
set to auto.

The default setting is to show images as thumbnails if they are more than 48 pixels high. If
that is the case, the image will be resized in the output to be 48 pixels high, and the width will
be adjusted accordingly. The image will be shown in its full size when the user performs one
of the actions you specified in the previous step.

If you want to change either the maximum width or height settings, first click in the upper-
right drop-down and select Length. Enter a number in the field and use the down arrow in the
lower-right corner to select a unit of measurement.

7. Click OK.

8. Click to save your work.
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What’s Noteworthy?

NOTE For Clean XHTML output, thumbnail images that are set as popups are converted to
linked thumbnail images (i.e., the enlarged image opens in a new window instead of in a
popup).

Creating Watermarks
A watermark is an image that is set in the background behind all your other content. You can make
watermarks for both online and print-based output.

How to Create a Watermark
1. Create an image with the watermark you want to use. Using your graphics software, you may

need to edit the image to lighten appropriately for background use.

2. Open the stylesheet you want to modify.

3. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

4. In the upper-left of the editor, make sure the drop-down field is set to
.

5. On the left side of the editor, find and select the body tag.
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6. From the Show drop-down list on the upper-right side of the editor, select .

7. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

8. If you are using the grouped view, expand the Background group.

9. To the right of background-image, click .

10. Select an image file to insert. You can do this in one of the following ways.

n Select an image already in the project by finding and selecting it in the built-in tree.

n Click to find and select an image file outside of the project.

NOTE If you want to select an image file recently inserted into your project, click the
down arrow in the field next to the button, and select the file from the list.

11. If you want a specific position for the background image, click to the right of background-
position and enter the appropriate command (definitions from http://www.w3.org).

n percentage A percentage X aligns the point X% across (for horizontal) or down (for
vertical) the image with the point X% across (for horizontal) or down (for vertical) the
element's padding box. For example, with a value pair of '0% 0%',the upper left corner of
the image is aligned with the upper left corner of the padding box. A value pair of '100%
100%' places the lower right corner of the image in the lower right corner of the padding
box. With a value pair of '14% 84%', the point 14% across and 84% down the image is to
be placed at the point 14% across and 84% down the padding box.

n length A length L aligns the top left corner of the image a distance L to the right of (for
horizontal) or below (for vertical) the top left corner of the element's padding box. For
example, with a value pair of '2cm 1cm', the upper left corner of the image is placed
2cm to the right and 1cm below the upper left corner of the padding box.

n top Equivalent to '0%' for the vertical position.

n right Equivalent to '100%' for the horizontal position.

n bottom Equivalent to '100%' for the vertical position.

n left Equivalent to '0%' for the horizontal position.

n center Equivalent to '50%' for the horizontal position if it is not otherwise given, or '50%'
for the vertical position if it is.
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12. If you want the background image to repeat, click to the right of background-repeat and
select one of the options (definitions from http://www.w3.org).

n no-repeat The image is not repeated. Only one copy of the image is drawn.

n repeat The image is repeated both horizontally and vertically.

n repeat-x The image is repeated horizontally only.

n repeat-y The image is repeated vertically only.

13. Click to save your work.

NOTE By default, most internet browsers do not automatically enable settings to print
background images. You will usually need to manually select an option to print background
images, such as watermarks.
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Linking Images
You can manage your image linking through the following:

Inserting Image Hyperlinks
After you insert an image, you can turn that picture into a hyperlink, connecting it to another topic, a
topic in an imported HTML Help file, an external file (such as a website), or an email.After you insert
an image, you can turn that picture into a hyperlink.

How to Insert an Image Hyperlink
1. Open the content file.

2. In the XML Editor, right-click the image that you want to use as a hyperlink.

3. In the context menu, select Hyperlink Image. The Insert Hyperlink dialog opens.

4. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based on the option you choose, the section below gives you a list of
selections or additional fields to complete.
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FILE IN PROJECT 

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog.

You can also select if you have selected a PDF file.
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PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare will insert a new bookmark at that
destination in the file.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click to display and select any bookmarks within the destination file, or if
you have selected a PDF file.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).
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EMAIL

This option lets you add email addresses and subject line so that the user can quickly send
an email. To add multiple email addresses, separate them with semi-colons.

EXAMPLE You might use this feature to help the end user send an email to your
company's technical support department. When users click the link, it opens their
email program and begins a new email message for them, inserting the email
address and subject line for them. After you click this option, complete the E-mail
address and Subject fields to the right (or select a recent email address from the list
below).
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HTML HELP FILE

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

n Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show Folders
button is selected, the area splits into two. The folder is shown on
the left side, and the files and subfolders within it are shown on the right.

n Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

5. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the hyperlink in the output. This is added not only a "title" attribute, but as an "alt"
(alternate text) attribute as well.

6. (Optional) Next to the Style Class field, click the Select button. This opens the Select Class
dialog, which lets you apply one of the defined hyperlink styles (a.NameOfStyleClass) from
your stylesheet to the link. After you select a style class in the dialog, click OK. The Style Class
field displays the selected style. (If you do not specify a style class, Flare uses the parent "a"
style.)
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7. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked
destination will open. This option can be used to open the destination topic or file in a popup.

n Page Default The destination file opens in the same window as the output window.

n Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

n New Window The destination file opens in a new browser window.

n Same Frame The destination file opens in the same window frame as the current topic.

n Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

n Popup Window The destination file opens in a popup box on top of the current topic.

8. (Optional) In the Tab Index field you can enter a value to specify the order in which users can
tab through links. So when a user presses the TAB key the first time, the hyperlink with an
index value of 1 will be selected first, the link with a value of 2 will be selected next, and so on.
If you want to skip a link, enter -1 in that field.

NOTE This feature is supported only in web outputs—HTML5, Clean XHTML,
WebHelp, WebHelp Plus.

9. Click OK. The hyperlink is added to the image in the topic. When a user hovers the cursor over
the image in the output, the cursor changes to a hand.

10. Click to save your work.
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WARNING It is recommended that you avoid creating links to snippets.This is primarily
due to the nature of snippets, which are designed to be inserted into multiple files. Let's say
you have a heading style in a snippet and that snippet is then inserted into 12 different
topics. In another topic, you might decide to create a cross-reference that points to the
heading in that snippet. But which of those 12 topics is it supposed to point to in the
output? There is no way for Flare to know this, so you could end up with some very
undesirable results. For this reason, it's a good idea not to link to any content in a snippet.

NOTE You can also create an image map on top of a picture. This lets you insert multiple
hyperlinks for specific sections of the image, as opposed to creating one hyperlink for the
entire image.

NOTE You can edit image hyperlinks that you have inserted into a topic in the following
ways: (1) edit the destination and properties of the hyperlink, and (2) remove the hyperlink
from the image. For more information see the online Help.
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Editing Image Hyperlinks
You can edit image hyperlinks that you have inserted into a topic in the following ways: (1) edit the
destination and properties of the hyperlink, and (2) remove the hyperlink from the image.

How to Edit the Destination and Properties of an Image
Hyperlink

1. Open the content file.

2. In the XML Editor, right-click the image.

3. In the context menu, select Hyperlink Image. The Insert Hyperlink dialog opens.

4. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based the option you choose, the section below gives you a list of selections
or additional fields to complete.

FILE IN PROJECT 

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.
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If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog.

You can also select if you have selected a PDF file.

PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare will insert a new bookmark at that
destination in the file.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click to display and select any bookmarks within the destination file, or if
you have selected a PDF file.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.
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WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).

EMAIL

This option lets you add email addresses and subject line so that the user can quickly send
an email. To add multiple email addresses, separate them with semi-colons.

EXAMPLE You might use this feature to help the end user send an email to your
company's technical support department. When users click the link, it opens their
email program and begins a new email message for them, inserting the email
address and subject line for them. After you click this option, complete the E-mail
address and Subject fields to the right (or select a recent email address from the list
below).
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HTML HELP FILE

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

n Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show Folders
button is selected, the area splits into two. The folder is shown on
the left side, and the files and subfolders within it are shown on the right.

n Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

5. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the hyperlink in the output.

6. (Optional) Next to the Style Class field, click the Select button. This opens the Select Class
dialog, which lets you apply one of the defined hyperlink styles (a.NameOfStyleClass) from
your stylesheet to the link. After you select a style class in the dialog, click OK. The Style Class
field displays the selected style. (If you do not specify a style class, Flare uses the parent "a"
style.)

7. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked
destination will open. This option can be used to open the destination topic or file in a popup.
The other options are typically used by advanced users.

n Page Default The destination file opens in the same window as the output window.

n Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.
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n New Window The destination file opens in a new browser window.

n Same Frame The destination file opens in the same window frame as the current topic.

n Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

n Popup Window The destination file opens in a popup box on top of the current topic.

8. (Optional) In the Tab Index field you can enter a value to specify the order in which users can
tab through links. So when a user presses the TAB key the first time, the hyperlink with an
index value of 1 will be selected first, the link with a value of 2 will be selected next, and so on.
If you want to skip a link, enter -1 in that field.

NOTE This feature is supported only in web outputs—HTML5, Clean XHTML,
WebHelp, WebHelp Plus.

9. Click OK. The hyperlink is changed in the topic.

10. Click to save your work.
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How to Remove the Hyperlink From the Image
Another way to edit an image hyperlink is to remove the hyperlink effect. If you decide that you no
longer want the image to serve as a hyperlink, you can use the steps below to remove the hyperlink.
When you are finished, the image will remain in the topic, but the hyperlink effect will be removed.

1. Open the content file.

2. In the XML Editor, right-click the image.

3. In the context menu, select Hyperlink Image. The Insert Hyperlink dialog opens.

4. In the bottom-left section of the dialog, click the Remove Link button. The hyperlink effect is
removed.

5. Click to save your work.
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Creating Image Maps
After you insert an image, you can create multiple hyperlinks for specific sections of the image.
This is called an "image map." Image maps engage online users to click linked parts of an image
that reveal more information.

The image map contains a “hotspot,” which is the part of the image that contains the link as you
hover the mouse on it (e.g., text, icon). It also contains a target frame property that determines how
the link opens (e.g., popup, tab, window).

The foundation of an image map can take on several forms, such as a graphic, photo, or map. The
image map is anything with identifiable clickable areas.

How to Create an Image Map
1. Open the topic.

2. In the XML Editor, right-click the image on which you want to create an image map.

3. In the context menu, select Image Map. The Image Map Editor opens, with the image
displayed.
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4. In the Standard toolbar of the Image Map Editor, click one of the shape drawing buttons,
depending on the area of the image that you want to use as a hyperlink.

Click this button if you want to draw an odd shape over a section of the image.

Click this button if you want to draw a rectangle over a section of the image.

Click this button if you want to draw a circle over a section of the image.

5. In the image, click and drag your mouse over the area to be used as a hyperlink. Release the
mouse button when you are satisfied with the size and location of the shape. You should now
see the shape on top of the image, connected by a series of points.

The Image Map Editor only draws clickable areas for the hyperlink (or hotspot). It does not
draw shapes and objects on the image. You will have to use another tool, such as MadCap
Capture, if you want to annotate the image itself.
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6. In the toolbar, click . The Area Properties displays.
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7. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based the option you choose, the section below gives you a list of selections
or additional fields to complete.

FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog.

You can also select if you have selected a PDF file.
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PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare will insert a new bookmark at that
destination in the file.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click to display and select any bookmarks within the destination file, or if
you have selected a PDF file.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).
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EMAIL

This option lets you add email addresses and subject line so that the user can quickly send
an email. To add multiple email addresses, separate them with semi-colons.

EXAMPLE You might use this feature to help the end user send an email to your
company's technical support department. When users click the link, it opens their
email program and begins a new email message for them, inserting the email
address and subject line for them. After you click this option, complete the E-mail
address and Subject fields to the right (or select a recent email address from the list
below).
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HTML HELP FILE

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

n Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show Folders
button is selected, the area splits into two. The folder is shown on
the left side, and the files and subfolders within it are shown on the right.

n Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

8. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the hyperlink in the output. This is added not only as a "title" attribute, but as an
"alt" (alternate text) attribute as well.
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9. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked
destination will open.

n Page Default The destination file opens in the same window as the output window.

n Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

n New Window The destination file opens in a new browser window.

n Same Frame The destination file opens in the same window frame as the current topic.

n Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

n Popup Window The destination file opens in a popup box on top of the current topic.

NOTE The Popup Window option is not supported in HTML5 online output formats
with Side Navigation and Top Navigation skin types. Either select an output format
that supports it, or in the Target Editor’s Skin tab, set the skin type to none.

10. (Optional) In the Tab Index field you can enter a value to specify the order in which users can
tab through hyperlinks in the image. So when a user presses the TAB key the first time in a
topic, the hyperlink with an index value of 1 will be selected first, the hyperlink with a value of
2 will be selected next, and so on. If you want to skip a hyperlink, enter -1 in that field.

NOTE This feature is supported only in web outputs—HTML5, Clean XHTML,
WebHelp, WebHelp Plus.

11. Click OK.

12. If you want to add more hyperlinks to the image, select a shape button again and repeat the
steps above.

13. When you are finished creating hyperlinks on the image, click OK in the Image Map Editor.

Notice that when the object is selected in the Image Map Editor, the link property fields at the
bottom are populated with the information you provided.

14. Click to save your work.
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How to Make Image Maps Responsive
Image maps are not natively responsive; meaning the image and its clickable area do not
automatically adjust depending on the user’s device and screen size. Because of this, it is a best
practice to set the image max width style property to 100%.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Using the Advanced view, select the img style.

3. From the local toolbar, select Show: All Properties.

4. Expand Unclassified, and set the max-width property to 100%.

5. Click to save your work.

NOTE This process makes the image itself responsive in the output. If you want the
clickable areas of the map to be responsive as well, you’ll have to download a Responsive
Image Maps jQuery Plugin from a GitHub repository.

If you would rather not download the jQuery plugin, you can remove the max-width
property. This would keep the image map and clickable areas in sync as users adjust the
output, but the image map and the clickables areas would not be responsive.
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Buttons and Sections in the Image Map Editor
Following are descriptions of buttons and sections found in the Image Map Editor.

Edit Use this menu to select basic editing options (such as undo, redo, cut, copy, and
paste). You can also open the properties for an object or apply conditions to it.

Click this button to toggle between seeing a clear image of the picture and a faded
image. This is only for your internal use; it will not affect the output.

Click this button to hide the shapes that you draw over areas of the image. This is
only for your internal use; it will not affect the output.

Click this button to fill the shapes that you draw over areas of the image. This is
only for your internal use; it will not affect the output.

Click this button to open the Area Properties dialog, which lets you find and select
a destination file to link to a shape that you've drawn. You must select a shape
before this button is enabled.

Click this button to delete a selected point in the editor.

Click this button to enable "Select" mode so that you can click on shapes that you
have drawn in the editor.

Click this button to draw a polygon shape over an area of the image. You can then
select the shape and link it to a destination file.

Click this button to draw a rectangle shape over an area of the image. You can
then select the shape and link it to a destination file.

Click this button to draw a circle shape over an area of the image. You can then
select the shape and link it to a destination file.
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Click this button to bring a shape up one layer (if it is overlapped by one or more
other shapes).

Click this button to bring a shape up to the top layer (if it is overlapped by one or
more other shapes).

Click this button to move a shape down one layer (if it is overlapped by one or
more other shapes).

Click this button to move a shape down to the bottom layer (if it is overlapped by
one or more other shapes).

Opens a dialog that lets you apply conditions to content.

Link Displays the path to the linked destination file for the selected object. This field is
automatically populated after you click to find and select a destination file.

Screen
Tip

Displays the screen tip (or "alt" text) for the selected object. An alt tag provides a
textual equivalent for the image. This code allows the page to be usable by
persons with graphics turned off or who are blind and using a screen reader. This
field is automatically populated after you click and enter the screen tip text.

Tab Index Displays the tab index value that you entered in the Area Properties dialog for the
selected object. The tab index is a value to specify the order in which users can tab
through links on an image. So when a user presses the TAB key the first time, the
link with an index value of 1 will be selected first, the link with a value of 2 will be
selected next, and so on. If you want to skip a link, enter -1 in that field. This
feature is supported only in web outputs—HTML5, Clean XHTML, WebHelp,
WebHelp Plus.
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Overlapping Objects and PDF Output
PDFs are limited to rectangular-shaped image map objects. Therefore, if you have an image map
with circle or polygon objects, those will be redrawn as rectangles in the PDF output. If this occurs,
Flare will include a compile warning. Also, keep in mind that if objects overlap one another, the one
on the top layer (usually the last one drawn) takes precedence.

EXAMPLE You have an image of the Olympic circles inserted into a topic:

You create an image map, drawing round objects around each of the five circles, and you
link each of these objects to a different website. For the purposes of this example, we're
showing dark green circles to represent each image map object:

Notice that the circles overlap in some places. In those locations, the circle object that is on
the top layer will win. Therefore, if the user clicks in that area, the website linked to the
object on top will be opened.
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Now, if you generate online output, such as HTML5, the circle shapes on the image map
will be retained, just as you see them above. But if you generate PDF output, each of the
circle objects will be converted to a rectangle, like this:

Therefore, the link areas (as well as the overlapping areas) are adjusted accordingly.

What’s Noteworthy?

WARNING It is recommended that you avoid creating links to snippets.This is primarily
due to the nature of snippets, which are designed to be inserted into multiple files. Let's say
you have a heading style in a snippet and that snippet is then inserted into 12 different
topics. In another topic, you might decide to create a cross-reference that points to the
heading in that snippet. But which of those 12 topics is it supposed to point to in the
output? There is no way for Flare to know this, so you could end up with some very
undesirable results. For this reason, it's a good idea not to link to any content in a snippet.
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CHAPTER 3

Other Information for Images
In addition to the primary concepts, there is some additional information that might help you when
working with this feature.

This chapter discusses the following:

Raster vs. Vector Images 80

PDF Files as Images 84

Image Features Per Output Type 88
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Raster vs. Vector Images
Flare supports common raster image formats such as BMP, GIF, JPG, and PNG. In addition, it
supports vector image formats such as EPS, PS, and SVG.

A vector image comprises geometric elements such as lines, points, and curves, based on
mathematical equations. On the other hand, raster graphics are made up of pixels. A vector image
is ideal for print-based output because the clarity is maintained even when you reduce the size of
the graphic. Vector images are supported in PDF output. If you generate another type of output, you
may find that some vector formats (e.g., SVG) are supported while others (e.g., EPS) are not due to
limitations of the browser or application. When a vector image is not supported in an output, it is
converted to PNG.

It is sometimes difficult to tell the difference between a vector and raster graphic when viewing it at
100%. But if you zoom in the difference becomes apparent. Following is an example of a PDF
document with the same image in JPEG and SVG format.
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The text in the SVG image is a little more readable. And if we zoom in, we can see why.

Here is what the JPEG image looks like when we zoom in at 300%. Notice that the pixels look blurry
when enlarged.
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And here is what the SVG image looks like. Notice that the text still looks as clear as it does at a
much smaller size.
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PDF Files as Images
You can insert pages from PDFs as images. When you select a PDF file, you can choose the
specific page from it to be inserted as an image.
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PDF images are supported in all outputs. However, the way these files are treated depends on the
output format:

n PDF If you generate PDF output, the page you inserted is kept as a PDF. So it's sort of like a
one-page PDF within a big PDF. You'll find that you can select text in that PDF image, just like
you can in the larger PDF.
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Also, any vector-based information is retained, therefore retaining the quality and clarity you
expect. This is especially useful if you inserted a PDF that contains Microsoft Visio diagrams
or vector drawings from CAD (computer-aided design) software.
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n All Other Outputs If you generate any output other than PDF, the PDF page you inserted is
converted to a PNG file, even if it contains vector-based drawings. That's largely due to the
fact that browser-based output types do not support vector images. Because the image
displays in a raster format, you will find that it is not as crisp as its vector counterpart in PDF
output.
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Image Features Per Output Type
Following are image features supported in each output type.

HTML5 PDF Word
Clean
XHTML

Eclipse
Help EPUB

HTML
Help

Absolute
Positioning

Image
Hyperlinks

Image Maps

Thumbnail
Images

Web-Safe
(Convert
From Non—
Web-Safe)

1For Clean XHTML output, thumbnail images that are set as popups are converted to
linked thumbnail images (i.e., the enlarged image opens in a new window instead of in a
popup).
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CHAPTER 4

Other Activities for Images
In addition to the main activities, there are some other tasks you might perform regarding this
feature.

This chapter discusses the following:

Selecting an Image for the About Box 90

Deleting and Removing Images 92

Creating and Editing Image Tooltips 100

Creating a List of Images 102

Opening Images 104

Adding Images to Page Layout Frames 105

Pasting Images From Other Programs 107

Pinning Images 109

Regenerating Images 115

Viewing Unused Images 117

Showing and Hiding Web Images in the XML Editor 119

Generating Web-Safe Images 120

Embedding Images in Word Output 121
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Selecting an Image for the About Box
Supported In:

You can select an image to be used for the "About box" in the output window. You can use this
About box for any purpose you like. When users click the icon…

… your image is displayed. When users click the image, it disappears.

How to Select an Image for the About Box
1. Open a Standard or Mobile skin.

2. Select the About tab.

3. Click Include About in output.

4. Click the Browse button.

5. In the Open dialog, find and select the image file that you want to use for the About box. A
preview of the image is shown at the bottom of the tab.

6. Click to save your work.

NOTE If you want to remove the image, click the Reset button.

NOTE This feature is available for Microsoft HTML Help only if you add a web toolbar to
the skin being used for that target. For more information see the online Help.
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How to Select a Different Image for the Icon
What if you want to use an image other than the default MadCap icon (the image that users click to
open the "About" box image")?

Use the following steps to accomplish this.

1. In the skin select the Styles tab.

2. In the Styles section, expand the Toolbar Item node.

3. Under it, click Logo.

4. Select the Property Groups option.

5. In the Properties section, click in the cell to the right of Icon.

6. Select Browse for Image.

7. In the dialog that opens, find and double-click the image that you want to use.

8. Click to save your work.
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Deleting and Removing Images
You can also do the following tasks to delete and remove images from your project:

Deleting Image Files From the Project
Use the following steps to remove an image file from a project. Image files are added to the project
automatically when you insert an image into a topic.

How to Delete an Image File From the Project
1. Open the Content Explorer.

2. Expand the Resources folder, and double-click the Images folder to open it (unless you stored
the image in a custom folder somewhere).

3. Locate and select the image file that you want to delete.

4. On your keyboard press DELETE.

5. You may be asked if you are certain you want to send the file to the recycle bin. If so, click
Yes.

Deleting Images From Content Files
Use the following steps to delete an image that you previously inserted into a content file.

How to Delete an Image From a Content File
1. Open the content file.

2. In the XML Editor, right-click the image.

3. From the context menu, click Delete. The image is deleted from the file.

4. Click to save your work.
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Removing Images From Headings in a
Generated TOC
Supported In:

If you have inserted images into the headings in your topics, you can make sure those images do
not appear in the generated TOC of the printed output.

This option works somewhat differently depending on the output type.

Word
n If the option is disabled, images appear in both content headings and the print TOC.

n If the option is enabled, images are removed from both content headings and the print TOC.

PDF
n If the option is disabled, images appear in content headings only.

n If the option is enabled, images are removed completely.

How to Remove Images From Headings in a Generated
TOC

1. Open the target.

2. In the Target Editor, select the Advanced tab.

3. In the Generated TOC section, select Remove images from paragraphs with heading levels.

4. Click to save your work.
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What’s Noteworthy?

NOTE Keep in mind that, with this feature, the images are also removed from the heading
in the content of the document. Therefore, if you want to have the images in the content,
but not in the print TOC, you should not use this feature. Instead, you must remove the
images from the print TOC manually after generation (if you compile an editable output,
such as Word).
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Removing Unreferenced Embedded Images
From Skins
Supported In:

When you add an image in a skin (e.,g., your company logo), that image becomes embedded in the
skin file using binary code. If you later replace that image, it remains embedded in the skin, even
though it is no longer being used (i.e., it is unreferenced). When you click the field to select an
image, you can still see the old image listed with others. This adds unnecessary size to your skin
file. However, you can select an option on the General tab of the Skin Editor to automatically
remove unreferenced images from the skin when you save the skin.
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How to Remove Unreferenced Embedded Images From
a Skin

1. Open a skin.

2. On the General tab of the Skin Editor, select Remove On Save.

3. Click to save your work.

EXAMPLE You add your company's logo to a skin, like this.
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Later you replace that image with another.

Even though you are no longer using the original image, you still see it whenever you try to
select an image from a field anywhere in the Skin Editor.
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Therefore, you open the General tab in the Skin Editor and select the option to remove
unreferenced images the next time you save.

Then you save the skin. Now when you try to select an image in the skin, you will no longer
see the original image listed, because it's been removed from the skin.
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What’s Noteworthy?

NOTE Removing unreferenced embedded images from skins is an action that cannot be
undone.

NOTE This option is not available in HTML Top Navigation skins. It is available only in
HTML5 Tripane skins.
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Creating and Editing Image Tooltips
When inserting or editing an image, you can add a tooltip (or screen tip), which displays in a popup
when end users hover over the image in the output. You can also use a generic style class named
"tooltip" to control the look of that popup and its text.

How to Create an Image Tooltip
1. Right-click on an image that has been inserted into a topic (or other content file), and select

Image Properties. The Image Properties dialog opens.

NOTE You can also use this dialog during the process of inserting a new image. See
"Inserting Images" on page 11.

2. In the Screen Tip field, type a phrase that you want to appear when the end user hovers over
the image.

3. (Optional) Select Apply the alternate text and screen tip to all image references if you want
the same screen tip text to be used everywhere the image is already inserted in the project.
However, this option will not affect new insertions of the image in the project; you would need
to add the screen tip text to those images manually.

4. Click OK.

5. If you selected the check box, click Yes to save the changes. Otherwise, click to save your
work.
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How to Edit the Look of Image Tooltips
1. From the Content Explorer, open your stylesheet.

2. In the local toolbar, click Add Selector.

3. Either clear the HTML Element field, or select (generic) in it.

4. In the Class Name field, type tooltip.

5. Click OK.

The new class is located under the "(Generic Classes)" node on the left side of the editor. You
might need to filter for All Styles to see it.

6. With the tooltip class selected on the left, set any properties for it on the right.

NOTE This is one case where you do not need to apply this style class to your
images manually, because Flare is designed to use it automatically whenever an
image has a screen tip added.

7. Click to save your work.
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Creating a List of Images
Supported In:

You can use the List-Of proxy to generate a list (or "table") of various types of elements (e.g., tables,
images) in your output, with links to the corresponding content.

How to Create a List of Images
1. At the top of a topic, enter a main heading for your list (e.g., "List of Figures"), and under it add

any other text or content you want.

2. Select Insert > Proxy > Insert List-Of Proxy. The List-Of Proxy dialog opens.

3. In the Tag Name field, select the parent tag to be used for creating the list.

EXAMPLE You have added a caption below each image in your project (e.g., Figure
5: My Image Caption). Perhaps you created a class of the p style called
"ImageCaption" (i.e., p.ImageCaption). In a case such as this, you would select p from
the Tag Name field when inserting the List-Of proxy.

4. (Optional) In the Tag Class field, select the style class to be used for creating the list.

EXAMPLE Using the example above, you would select "ImageCaption" from this
field.
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5. (Optional) In the Stylesheet class for each generated entry field, you can select yet another
style class to determine how each item in the generated list looks.

You would use this style class, for example, if you want to change the font of the entries or
add a leader (e.g., series of dots) between the entries and the page numbers. For more
information about using styles, including steps, see the online Help or the Flare Styles Guide.

6. (Optional) In the Stylesheet class for proxy field, you can select a class to affect the look of
the entire list.

You might create and use a proxy style class, for example, if you want to add a border around
the generated list. If you do not select a class from this field, the list will use the style settings
from the parent MadCap|listOfProxy style. You have the option of creating a class for this
proxy style in the Stylesheet Editor. To do this, select the MadCap|listOfProxy style and in the
local toolbar click Add Selector to create a class. The class will then be available from this
field.

7. Click OK. The proxy is added to the topic.

8. Click to save your work.
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Opening Images
You can open an image that you have added to your project. When you open the image, it displays
in the Image Viewer within Flare.

How to Open an Image
1. Open the Content Explorer.

2. Expand the Resources folder, and double-click the Images subfolder. Traditionally, image files
are displayed under the Images subfolder (although they can also be placed in custom
folders).

3. Do one of the following:

n Locate and double-click the image file that you want to open.

n Locate and click the image file that you want to open. In the local toolbar, click .

The image opens in the Image Viewer.

NOTE You can also right-click on an image where it has been inserted and select Open Link
from the context menu.

NOTE If you have inserted a PDF file as an image, the actual PDF file opens. This is
different from other image formats, where the image opens by itself in the Image Viewer.

NOTE If you have imported a project that already contained images, Flare keeps the
images in the file structure of the source project (as opposed to placing the image files in
the Resources folder).
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Adding Images to Page Layout
Frames

Supported In:

If you want to insert an image so it automatically appears in several (or all) pages in the output, you
can create an image frame in a page layout.
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How to Add Images to Page Layout Frames
1. Open the page layout. The Page Layout Editor displays.

2. In the local toolbar, click the New Frame button .

3. In the drop-down, select New Image Frame. The Insert Image dialog opens, prompting you to
provide an image file.

4. Select an image file to insert. You can do this in one of the following ways.

n Select an image already in the project by finding and selecting it in the built-in tree.

n Click to find and select an image file outside of the project.

NOTE If you want to select an image file recently inserted into your project, click the
down arrow in the field next to the button, and select the file from the list.

5. Click OK. The image is added to a frame of the same size, which you can place on the page as
necessary.

6. Click to save your work.

NOTE In addition to using image frames, you can open other content frames (header,
footer, decoration) and insert images as you normally would.
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Pasting Images From Other Programs
You can copy and paste an image from another program, such as Microsoft Word, into a content
file (e.g., topic, snippet). When you do this, a copy of the image file is added in PNG format to your
project with a name that you provide.

TIP Before copying an image from another application, you should set its size to 100%.
This enables you to resize the image later within Flare without loss of quality. On the other
hand, let's say you resized the image to 50% in Microsoft Word and then pasted the image
into Flare. Later, you decide to enlarge the image in Flare. But in the output the quality does
not look very good because it was necessary to add pixels.
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How to Paste Images From Other Programs
1. After copying the image in the other program, open a content file (e.g., topic, snippet) in Flare.

2. Place your cursor where you want to paste the image.

3. Press CTRL+V on your keyboard.

4. In the Save Image dialog that opens, find and select the folder where you want to add the
copy of the image in your project (the default location is the Resources\Images folder). You
can use the buttons in the local toolbar to navigate.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show Folders button
is selected, the area splits into two halves. The folder is shown on the left

side, and the files and subfolders within it are shown on the right.

Shows or hides hidden files and folders.

If the Show Files button is the only one selected, you can click this button to
move up one folder level.

5. In the File name field, enter a name for the image.

6. Click Save. The image is added.

7. Click to save your work.
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Pinning Images
You can pin your favorite images so you can easily find them again later. Pinned images appear in a
group that you can expand or collapse. This is a way to limit the list of images to those that you use
the most.

You can pin any image that appears in the Recently Used Images group. This group lists your 20
most recently used images.

EXAMPLE Three images have been added to the Pinned Images group. Other recently
used images can still be seen in the Recently Used Images group; you can add any of these
images to the Pinned Images group at any time.
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How to Pin an Image—Insert Image Dialog
1. Open the content file.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Insert > Image.

n Local Toolbar Click the face of the button.

OR

Click the down arrow next to , then select More Images.

n Keyboard Shortcut Press CTRL+G.

n Right-Click Right-click in the editor and select Insert > Image. This context menu option
is available only when your cursor is located in certain places in the editor (e.g., not in a
drop-down effect).

The Insert Image dialog opens.

3. From the Recently Used Images group, select the image you want to pin. A pin appears to
the right of the image.

NOTE Images must appear in the Recently Used Images group before they can be
pinned. If the image you want to pin does not appear in the Recently Used Images
group, you can add it to a content file by dragging it from the Content Explorer or
using the Insert Image dialog.
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4. To pin the image, click . The pin changes to to show that the image has been pinned to
the list. Pinned images are added to the Pinned Images group in alphabetical order.
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5. To unpin the image, click the pin again and it will be moved back to the bottom of the
Recently Used Images group.

6. Click OK.
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How to Pin an Image—Local Toolbar Drop-Down
1. Open the content file.

2. In the local toolbar at the top of the XML Editor click the down arrow next to . This
expands the Insert Image drop-down.

3. From the Recently Used Images group, select the image you want to pin. A pin appears to
the right of the image.

NOTE Images must appear in the Recently Used Images group before they can be
pinned. If the image you want to pin does not appear in the Recently Used Images
group, you can add it to a content file by dragging it from the Content Explorer or
using the Insert Image dialog.

4. To pin the image, click . The pin changes to to show that the image has been pinned to
the list. Pinned images are added to the Pinned Images group.

5. To unpin the image, click the pin again and it will be moved back to the bottom of the
Recently Used Images group.

CHAPTER 4  113



What’s Noteworthy?

NOTE The Recently Used Images and Pinned Images groups show the relative path
location of each image. Hover over any image to see its full file path.

NOTE You can expand or collapse the Recently Used Images and Pinned Images groups by
clicking the arrows next to each group name.
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Regenerating Images
You can quickly regenerate (update) all of the images in your project.

How to Regenerate Images
Select Tools > Regenerate Captured Images.

The two primary reasons for using this option are:

n Remove Trial Watermarks If you install Flare on a trial basis before purchasing the product,
watermarks appear on all images that you capture and insert during the trial period. After you
become a licensed user, you can use this option to remove the watermarks on all images.

n Modify PROPS Files If you manipulate the PROPS file that accompanies an image file, the
image file becomes out of sync with the PROPS file. The "Regenerate Captured Images"
option updates the images based on the latest PROPS files.

What is a PROPS (or "Properties") file? It is a file created along with an image file in MadCap
Capture to hold all of the property information about that image.

EXAMPLE You use MadCap Capture to create a JPG image and you name it
"MyImage." You add a text callout to the image in Capture. Therefore, when you are
finished you will have one file called "MyImage.jpg," which is the raw image file. Along
with this file, you will have another file called "MyImage.jpg.props," which contains
the information about the text callout that you added to the image.
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One reason to manipulate the PROPS file is to translate the text into another language.

EXAMPLE You write an English version of your Flare project, and you have it
translated into Spanish as well. This includes any text found in your images, such as
this one.

You make a copy of this image file and the associated PROPS file, and you add them
to the Spanish version of your Flare project. Now you need to translate the callout
text for the image. So you open the PROPS file in Notepad and you change the text.

But when you look at the image in the Spanish version of the Flare project, the callout
text for the image is still in English. Therefore, you select Tools > Regenerate
Captured Images. The image is updated and now looks like this in your project.

NOTE If you need to translate image callouts in a Flare project, it is recommended
that you use MadCap Lingo, rather than manually editing each PROPS file in an editor
such as Notepad.
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Viewing Unused Images
You can view a list of all images that have been created in your project but have not yet been used
in any topics or other files. You can quickly delete any of the images that you do not plan to use.
You can also add condition tags to the images. For more information about images, see the Flare
Images Guide or the Flare online Help.

How to View Unused Images
1. Select Analysis > More Reports > Unused Items.

The Unused Items window pane opens, which lets you view various unused elements in the
project (such as bookmarks, condition tags, content files, CSH IDs, images, variables, styles,
file tags, meta tags, and topics not linked).

2. Click the drop-down field at the top of the window pane and select Unused Images. The
unused images in the project are listed.

3. To see more of the information in the window pane, drag the divider bar to make the pane
wider.

n Condition Tag Displays the condition tag for the image not being used.

n File Displays the name of the image file not being used.

n Folder Displays the folder where the file is found.

4. If a certain number of items have been found, page navigation buttons in the local toolbar
may be enabled. You can use these buttons to go to additional pages to display more items.
You can also click View All in the local toolbar to see all results on a single page. Keep in mind
that the more items you have in the project, the longer it will take to load this view.

5. If you want to remove any unused images from Flare, as well as from the project being
analyzed, select the image in the list and click in the local toolbar.
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6. (Optional) You can add condition tags to the unused images. To add condition tags, do the
following.

a. Select Unused Images from the drop-down menu in the Unused Items window pane.

b. Do one of the following:

n Click the button in the local toolbar.

n Right-click the image and from the context menu, select Properties.

n Right-click the image and press  CTRL+SHIFT+P on the keyboard.

The Properties dialog opens.

c. In the Properties dialog, click the Conditional Text tab.

d. Select condition tags, then click OK.

NOTE You can open the image file for any picture in the list to view it in the Image Viewer.
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Showing and Hiding Web Images in
the XML Editor

You might have many image tags that link to websites, rather than linking to images.

For example: <img src="http://www.madcapsoftware.com/images/home/company.png" />

Keep in mind that slow website response times may slow down your work. Therefore, you might
want to disable the rendering of such images in the XML Editor.

How to Show and Hide Web Images in the XML
Editor

1. Select File > Options.

The Options dialog opens.

2. Select the XML Editor tab.

3. Click Show web images. A check mark in the box indicates that the feature is enabled.

NOTE If you are using the "generate web-safe images" option in WebHelp targets, images
that link to external locations, such as websites, are not affected by that option. See
"Generating Web-Safe Images" on the next page.
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Generating Web-Safe Images
Supported In:

If you have used non–web-safe image formats (e.g., WMF, EMF, BMP, TIF, TIFF) in your project and
want those images to be converted to web-safe formats (e.g., GIF, JPEG, PNG) when you generate
online output—e.g., HTML5, Clean XHTML, Eclipse Help, Microsoft HTML Help, WebHelp, WebHelp
Plus—you can use an option on the Advanced tab of the Target Editor. For print-based output types
(Adobe PDF, Microsoft Word), the original image file formats will be used when you generate
output.

How to Generate Web-Safe Images
1. Open a target.

2. Select the Advanced tab.

3. Select Generate "web-safe" images.

4. From the drop-down list, select the image format that you want to use.

5. Click to save your work.

NOTE If you are using this option, images that link to external locations (such as websites),
rather than to images within the project, are not affected.
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Embedding Images in Word Output
Supported In:

An option on the MS Word Options tab of the Target Editor lets you ensure that images are
embedded in Microsoft Word output.

How to Embed Images in Word Output
1. Open the target being used for Word output.

2. In the Target Editor, select the MS Word Options tab.

3. Click the check box next to Embed images in output.

4. Click to save your work.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.

Tutorials
Getting Started Tutorial

Autonumbers Tutorial

Back-to-Top Button Tutorial

Context-Sensitive Help Tutorial

Custom Toolbar Tutorial

eLearning Tutorial—Basic

eLearning Tutorial—Advanced

Image Tooltips Tutorial

Lists Tutorial

Meta Tags Tutorial

Micro Content Tutorial—Basic

Micro Content Tutorial—Advanced

Responsive Output Tutorial

Single-Sourcing Tutorial

Snippet Conditions Tutorial

Styles Tutorials

Tables Tutorial

Word Import Tutorial
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Cheat Sheets
Context-Sensitive Help Cheat Sheet

Folders and Files Cheat Sheet

Learning & Development Cheat Sheet

Lists Cheat Sheet

Micro Content Cheat Sheet

Print-Based Output Cheat Sheet

Search Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet
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User Guides
Accessibility Guide

Analysis and Reports Guide

Architecture Guide

Autonumbers Guide

Branding Guide

Condition Tags Guide

Context-Sensitive Help Guide

Eclipse Help Guide

eLearning Guide

Getting Started Guide

Global Project Linking Guide

HTML5 Guide

Images Guide

Import Guide

Indexing Guide

Key Features Guide

Lists Guide

MadCap Central Integration
Guide

Meta Tags Guide

Micro Content Guide

Navigation Links Guide

Plug-In API Guide

Print-Based Output Guide

Project Creation Guide

QR Codes Guide

Reviews & Contributions With
Contributor Guide

Scripting Guide

Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide:
Perforce Helix Core

Source Control Guide:
Subversion

Source Control Guide: Team
Foundation Server

Styles Guide

Tables Guide

Tables of Contents Guide

Targets Guide

Template Pages Guide

Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker
Guide

Translation and Localization
Guide

Variables Guide

Videos Guide

What's New Guide
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